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Spam Celebrates Silver Jubilee
One of the most annoying aspects of "spam" which has subsequently become apthe internet, spam, is 25 years old this plied to junk mail thanks to a Monty Python
sketch in which customers of a restaurant are
weekend.
Net historians have trawled records and found
that the first junk e-mail message hawking a
company or its wares was sent back in 1978.
Coincidentally, the first commercial spam
sent to Usenet discussion groups was sent a
little over 10 years ago.
Now spam is thought to account for up to
40% of all e-mail messages sent across the net
and many industry groups, companies and
technologists are uniting to fight the flood.
Hawking history
Research by net alumni Brad Templeton has
found that the first spam message was sent
back in the days when the internet was known
as Arpanet.
By 1978 Arpanet had been operating for
about nine years and was letting lots of people
at universities and government bodies swap email.
On 3 May a marketing executive at Digital
Equipment Corporation, a leading maker of
minicomputers, decided to send all West
Coast Arpanet users a message about an open
day that would show off its new range of machines.
The message generated huge controversy
within the Arpanet community, partly because
it was so poorly written and because it clearly
broke the nascent network's acceptable use
policy.
As a research aid, e-mail messages on Arpanet were supposed to be non-commercial.
This messages pre-dated the use of the term
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offered spam with everything.
Mr. Templeton has also found the first use of
the term "spam" to describe a junk e-mail
message.
On 31 March 1993 Usenet administrator
Richard Depew inadvertently posted the same
message 200 times to a discussion group.
Adopting a term previously used in online
text games, outraged Usenet users branded
the excessive message posting "spam".
Another milestone in the history of spam took
place in April 1994 when Arizona law firm
Canter and Siegel posted a message about
green card lottery services to hundreds of
Usenet discussion groups.
From there spam has grown and grown and
now, according to figures from spam stopper
Brightmail, accounts for 40% of all e-mail
traffic. In 2001, spam was only 8% of all email traffic.
Not only does spam annoy people, most of
the offers made in the messages are bogus.
A study for the US Federal Trade Commission found that almost 66% of the 1,000 junk
mail messages scrutinized were false in some
way.
The report lends credence to speculation that
spammers send the messages only to entice
people to respond so they can draw up a huge
list of live e-mail addresses that they can then
sell on to others.
Submitted by Mike Clark
Story from BBC News 2003/05/04
http://news.bbc.co.uk/go/pr/fr//1/hi/technology/2996319.stm

The Flea Market will not be held this year….

PAGE 2

MOTHERBOARD

Proposed Spam Bill Would Favor
Mass Mailers
By Roy Mark

Reps. W.J. "Billy" Tauzin (R.-La.) and F. James
Sensenbrenner (R.-Wis.) are preparing to introduce
junk e-mail legislation that provides a measure of
consumer protection from spam but mostly favors
businesses that want to continue to exploit the advertising potential of mass e-mails.
According to a draft copy of the bill obtained by
The Washington Post, the bill would require emailers to provide accurate electronic and physical
addresses, prohibit harvesting of e-mail addresses
and allow consumers to opt-out of e-mail offerings.
However, the legislation, which may be introduced
as early as this week, would supercede tougher state
anti-spam state laws, bar consumers from suing
mass e-mailers and allow companies to send e-mail
to anyone who has done business with the companies within the previous three years.
http://dc.internet.com/news/article.php/2205491
Submitted by John Souvestre

F i z z e r Wo r m I s o n t h e M o v e
By Dennis Fisher
The Fizzer worm continued to spread rapidly late
Monday afternoon as anti-virus experts raced to
analyze the code of what they called one of the
more complex worms in recent memory. First seen
late last week, Fizzer began spreading in Asia initially but then hit Europe and North American hard
Monday as office workers started to open e-mails
received over the weekend.
As of 4:30 EDT Monday, MessageLabs Inc., a managed service provider in New York that tracks virus
activity, had seen more than 25,000 copies of the
worm, making it the fifth-most prevalent virus on the
Internet this month.
"This is one of the more complicated worms
we've seen", comments Mikko Hypponen, manager of anti-virus research at F-Secure Corp.,
based in Helsinki, Finland. "The worm is 200kB
of code spaghetti, containing backdoors, code
droppers, attack agents, key loggers and even a
small Web server."
The new worm has several other capabilities that
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make it particularly troubling and dangerous. Fizzer
includes an IRC bot that attempts to connect to a
number of different IRC servers and, once it establishes a connection, listens passively for further instructions. This kind of activity is often the precursor to a distributed DoS (denial-of-service) attack.
The worm also has the ability to create a new user
account on AIM (AOL Instant Messenger), join a
chat session and then listen for instructions.
But perhaps the most interesting aspect of Fizzer is
the HTTP server it contains. The server runs on a
configured TCP port and in effect acts as a command
console, according to an analysis of the worm by the
AVERT team at McAfee Security, part of Network
Associates Inc., in Santa Clara, Calif. The console
gives the attacker a wealth of information about the
infected system, such as its operating system, connection information, and IRC and AIM data.
The HTTP server also gives the attacker the ability to
remotely launch DoS attacks, further propagate the
work via e-mail, issue commands to the IRC and
AIM bots, and kill anti-virus applications.
The keystroke logger records every typed letter and
saves the log in an encrypted file on the infected machine. If the infected PC has the Kazaa file-sharing
program installed, Fizzer also has the ability to find
the default download location for Kazaa files and
copy itself to that folder. It will have a random filename and could easily be mistaken for a media file
and downloaded by another Kazaa user.
At its heart, Fizzer is a mass-mailing worm that arrives in users' mailboxes in an e-mail with a random
subject line and body text. The attachment containing the worm is an executable file, but has a random
name and may also have a random file extension
that disguises the fact that it is an executable.
Source: eweek
http://www.eweek.com/print-article/0,3668,a=41494,00.asp
May 12, 2003

Make Web Text Larger
If you have trouble reading the text on a Web
page, you can make it larger and easier to read.
To do this, from the View menu, select Text Size
(in IE 5 and above) or Fonts (in IE 4). Select the
Larger or Largest text size from the list for easier viewing.
Source: Space Coast PC Journal, June 2003, Page 14
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What is a Pirate?
Of course I am not talking about bearded men living on ships with tattoos, hooked hands and
wooden legs. In the software industry, a pirate is someone (anyone) who copies a software program, whether they bought it or not. Most End User License Agreements (EULAs) allow you to
make one backup and use the program on one other computer, like a laptop. Some don't even
allow you to do that. Some state you can't sell or rent the program or use it on more than one computer-ever.
What if you applied such a restrictive condition to other things you buy, like a car, for instance. The car
costs you 30 times what it costs to make it in Detroit. But if you buy it, you can drive it but your wife and
children may not. You can't sell or rent this car, and you really don't own it. Then, there's a twenty-five cent
disk, with ten dollars worth of packaging and twenty dollars worth of printing, that sells for eight hundred
dollars.
In the early eighties, when DOS was on a floppy and a floppy was a floppy on the IBM 8088 with 256k
RAM, Microsoft (a baby company which I wish I had bought stock in) could largely attribute its existence
and future to a program called Lotus 1-2-3. You put your 51/4-inch floppy disk in to load DOS 2.x
(Windows was not yet available) and it loaded DOS into RAM. Then you took that disk out of the floppy
and put in another floppy with Lotus 1-2-3 on it, and built a spreadsheet on an amber monitor (color monitors were too expensive to justify). I cut my teeth on with computers on such a system and on an IBM System 32 mainframe that used programs written in Cobol. My position as the Inventory Control Supervisor
afforded me the opportunity to learn Lotus 1-2-3, the hottest thing in business software at the time. Businesses bought computers that ran DOS just to use Lotus 1-2-3.
Lotus was a little slow in developing a Graphic User Interface (GUI), and Microsoft seized the opportunity
to excel with their Excel program and develop the office suite we know as MS Office, which ultimately
dwarfed Lotus and the upstart Quattro Pro.
Back in those early years, I pirated (copied) the Lotus 1-2-3 DOS version that I used primarily to learn how
to use it. This had benefits to me for educational purposes. The free-use clause in the copyright law excludes educational use, but it only applies to educational institutions. I think it should apply to all not-forprofit use. Most loss of revenue due to "piracy" takes place overseas by counterfeiters, not by Joe Blow in
his living room. This is the reason the software companies go after the corporations that "pirate" software
rather than the common man. It's all about money. Corporations have deeper pockets and prosecuting individuals would be bad public relations. But aside from that, the "software companies application of the law,"
which is usually the one upheld by the courts, makes most everyone in America from age 9 up a criminal.
My copying and learning Lotus had benefits for Lotus, too. I was able to master it and promote at other
companies. When I began to use it in a personal business for profit, I bought a legal copy. I then felt it was
no longer for education, and if I used it in any way to profit, I should purchase it. I still have the old DOS
version of Lotus 1-2-3 on 51/4-inch floppies, which are pretty much worthless now, but I paid what was an
enormous amount of money for me at the time. I bought Lotus Smart Suite more recently; Excel's dominance of the market has made the price of Lotus and Corel Office pretty cheap. I use mostly a legally purchased copy of Excel these days. Apply the law literally, the software developer's way, and I committed a
criminal act.
So, what's the solution? Back in the early days, when you actually got a printed manual with everything, it
seemed easy for me-make software cheap (under $50 for anything) and it would be more expensive to du(Continued on page 4)
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(Continued from page 3)

plicate than to buy. It seems to me that the price
gouging some software companies were guilty of, in
my opinion, made them the real "pirates." This may
be rationalizing, but there is a lot of truth to it.
I believe a company should be able to fix price,
even if they have no competition, or drive the competition out of business, as long as when I pay their
price, the property is mine. That means I can copy
it, loan it, resell it, etc.-just like a car. If I can't do all
that, then just like there are usury laws to prevent
companies from exploiting the poor, there should be
laws fixing software prices within everyone's income level. That's not going to happen, nor should
it, but the software companies have been having
their cake and eating it too, and the individual who
can't afford five, six, eight hundred dollars, or more,
for one program has been demonized as a "pirate." I
will leave it to you to decide who is the pirate.
These days software vendors have moved away
from fancy packaging and no longer provide manuals. Help and upgrades are online and vendors have
distanced from the customer as much as possible.
The public has rebelled against inequities in the law,
and the backlash caused by the software developer's
demonization of the public has driven the public to
"pirate" even more. Today a large percentage of
computer users use KaZaa.com and imesh.com to
download anything they want. Napster made a big
noise in the news a year ago, but morpheus.com
makes napster.com look mild in comparison.
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Peter Coffee wrote an article in eWeek magazine last
month where he said, "When legislators make foolish laws, or courts enforce laws foolishly, they teach
people to justify doing whatever they want. In particular, when teenagers spend their formative years
acquiring contempt for laws that are made by the
ignorant at the behest of the selfish, I fear for the
consequences when those young people become our
next generation of leaders." (eWeek February 3,
2003, page 45)
Mr. Coffee has a good point. The music industry
and the software industry have failed to understand
their reason for being. I am not trying to encourage
anyone to "pirate" software, but I would like you to
realize that the issue is extremely complex, and the
moral ramifications are vastly vague. If the laws are
changed, I believe they should be relaxed rather
than tightened. But that is unlikely since the software industry has all the lobbyists and the power of
money is on it's side, and bribing a politician is illegal, unless you are a lobbyist or Political Action
Committee.
Reprinted from PC Register, March 2003, the Official Journal
of the East Tennessee Computer Society. Art Shady is Editor
of the PC Register.

As found in “Bits & Bytes” Official Newsletter of the
Tampa Bay Computer Society
www.tampa-bay.net
June, 2003

Why do some sites get away with it and others
don't? Because they are not located in America.
They are hosted in a country where America has no
jurisdiction. Software prices continue to get ridiculously high, but the software industry would be
quick to blame this on all the money they are losing
to "pirates."
There's another factor too-what is legal or ethical?
Laws change. What was legally acceptable last year
may be illegal today, and vise-versa. This brings us
to the question of what should be legal or what is
ethical. Are the consumers getting a fair shake, and
Disable Animated GIFs, IE 5/6
are the software developers who charge enough for To disable animated GIFs, select Internet Options from
some network solutions to buy a house getting a fair the Tools menu and click the Advanced tab. Scroll
shake?
down to the Multimedia section, un-check the Play AnYou decide.

imations option and click OK. From now on, you'll see
only the first frame of each animated GIF that loads.
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Little Bits
Categorize E-mail

Delete Data, Microsoft Excel

Outlook can help you assign categories automatically to your e-mail based on the identity of the
recipient or the contents of the message. To set up
a rule for assigning a category, from the Tools
menu, choose Rules Wizard, then click the New
button. To categorize your outgoing messages
based on their recipients, choose Assign Categories To Sent Messages. To categorize messages
received from others based on their content,
choose Assign Categories Based On Content.
Then step through the Wizard and select the types
of messages to which the rule should apply.

There are several ways to delete data from worksheet cells. To clear information but not formatting, select the data, then press either the Delete or
Backspace key. To remove formatting, select the
cells, choose Clear from the Edit menu, then select Formats. To remove both information and formatting, select the cells, choose Clear from the
Edit menu, then select All.

Does a Faster Drive Mean a Faster
System?

A vicious worm can cause several nasty symptoms, including shuffling icons and a malfunctioning WordPad.
• When Windows 98 SE starts, a message
box pops up, saying that it cannot find the
file Iexplore.exe (or one of its components).
• Every time I start Internet Explorer, it alters
the file Riched20.dll, which prevents WordPad from working. I found this line in
System.ini file: SHELL=EXPLORER.EXE
IEXPLORE.EXE.
• When I put my mouse pointer near my
Desktop icons, they shuffle and move
around. I haven't changed anything recently, but now an error message appears
reading Failed to create empty document
when I open WordPad.
• What do all these problems have in common? They all have the same answer. The
problem is caused by a virus (or Trojan
horse). The Nimda worm meddles with
Riched20.dll and prevents WordPad from
working properly.
A number of viruses make Desktop icons move
around, including the rather nasty Magistr e-mail
virus. Some Trojans install themselves using the
SHELL= line in System.ini, using a safe-looking
filename like IEXPLORE.EXE.
If your computer starts acting strangely, that doesn't automatically prove it has a virus, but after noticing odd behavior, your first step should be to
update your antivirus software and run a full system scan. If you're not running an antivirus program, your computer is wide open to a vast range
of malicious software.

Installing a fast hard drive is great, but you'll need
to follow our recommendations to make sure your
system gets a speed boost
You may notice a fairly good increase in
speed. Then again, you may notice no difference at all.
The faster the hard drive, the faster your operating system and its applications load, and the
faster any kind of disk access executes. If your
operating system is installed on the slower drive,
however, some important files from many apps
will also load on that drive, even if you install
the applications themselves on your faster drive.
In such a case, the slower drive will slow those
apps.
If you do buy a new, faster drive, the best approach is to put your operating system and the applications you use most frequently on the faster
drive. It's also important to keep the drive defragmented, so you don't defeat your speed advantage.
Before buying a drive, however, there are a
number of things to keep in mind. First, you can
put a maxi-mum of four IDE/ATA drives into
your system, no matter how you mix and match.
That includes hard drives, DVD drives, CD-ROM
drives, and CD burners. Second, if you want your
ATA-100 drive to operate at its top speed, you
must have a drive controller designed for that
speed (either on the motherboard or as a separate
peripheral card). Furthermore, your system's
BIOS must also support that speed.

Erratic Behavior May Mean Virus,
Win98SE

Reprinted from “The Space Coast PC Journal”, June 2003
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June Speaker
At our June meeting, Steve White will be showing
us some new technology products, specifically the
IO Pen from Logitech, the most recent Palmpilots
and the new Tablet PC’s. Steve and his team will
demonstrate these products and answer questions.
This will be a great opportunity to see these gadgets
up close and personal and learn how they can help
you at work and home.
Steve has been with FranklinCovey for nearly eight
years in various roles as Assistant Manager, Store
Manager and for the past year Business Outreach
Coordinator.
Another “Virus” Report
It seems that a virus is out there called the C-nile
Virus that even the most advanced Antivirus programs cannot take care of, so be warned.
Symptoms of C-nile Virus (Pronounced SENILE)
Note: It appears to mainly affect those of us who
were born before 1958!
1. Causes you to send same e-mail twice.
2. Causes you to send blank e-mail.
3. Causes you to send to the wrong person.
4. Causes you to send back to person who sent it to
you.
5. Causes you to forget to attach the attachment.
6. Causes you to wonder who all the people in your
address book are.
7. Causes you to hit "SEND" before you've finished
the…
Submittted by Jeanne Okamoto

Suggestion for Prospective
Computer Buyers
KNOW EXACTLY WHAT THE COMPUTER
CONTAINS: A recent example involved the purchase of a new notebook (formerly referred to as a
laptop) computer. The manufacturer's literature includes the following information:
Media Drives
Allows information to be stored on discs and transported from PC to PC.
Floppy Drive
Integrated 6 In 1 memory card reader

Expecting to receive a computer with a drive that
would handle six different storage media, including
as one of them, the ability to handle 1.44-megabyte
floppy disks, the buyer was surprised that the unit
did not include a slot that would even fit a standard
3.5" disk. With the new User's Guide in hand, the
buyer finds the `small print'. It turns out that the six
card types the unit supports are CompactFlash®,
IBM Microdrive, Memory Stick®, MultiMediaCard,
Secure DigitaI, and SmartMedia. Also in the User's
Guide, the new owner is advised that, "...if you need
to use a diskette drive, the manufacturer recommends purchasing a USB diskette drive, followed
with the manufacturer's many easy to use contact
addresses. An additional consideration may involve
the need for a USB hub, depending on the total requirements for this type of connection.
Ah yes, another satisfied customer.
Submitted by Carl Henderson

Fed Up With Doubleclick cookies?

I don't remember where I saw this, but some of
you may have noticed that if you use AdAware or
another spyware sniffer, it usually finds a cookie
by Doubleclick on your machine. Take it off and
it will be right back. They actually provide a way
to opt out of that situation. Point your browser to
[http://www.doublcclick.com/us/corporate/privacy
/privacy/ad-cookie/].One click at the bottom will
do it, but be sure to read the caveat on their Web
site. After opting out, it tells you which cookie
NOT to delete; otherwise you have just defeated
your objective.
Borrowed from the “Space Coast PC Journal:
June, 2003 Edition

Editor: Check out this Club’s newsletter which is
published online: http://scpcug.com
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NOPCC Directory
Elected Officers
President
Vice President
Secretary
Treasurer
Director At Large
Director At Large
Director At Large

Ray Paternostro
Ashton C. Mouton, Jr.
Carl Henderson
Don Herrmann
Louis G. Dutel, Jr.
Clarke Kissel
Albert Fox

BBS SysOp
Newsletter Editor
Public Relations
Publicity
Webmaster

Lanny Goldfinch
Edward Jahncke
Jeannie Okamoto
Jackie Elliott
Manuel Dennis III

president@nopc.org
vp@nopc.org
secretary@nopc.org
treasurer@nopc.org
director1@nopc.org
director2@nopc.org
director3@nopc.org

737-9099
246-7759
466-3954
831-1284
831-0055
828-5678
269-5786

Standing Committees
sysop@nopc.org
editor@nopc.org
pr@nopc.org
publicity@nopc.org
webmaster@nopc.org

482-5066
897-1205
455-0977
455-6203
835-7656

Special Interest Groups
Digital Media
Genealogy
Internet
New Users
VBLG
Web Development
WADSIG
Web Lab

Ray Paternostro
Bob Gordon
Ray Paternostro
Don Herrmann
Manuel Dennis III
Ashton C. Mouton, Jr.
Manuel Dennis III
Sherrie K. Henne

dm@nopc.org
gene-m@nopc.org
internet-m@nopc.org
new-user-m@nopc.org
vblg-owner@listbot.com
web@nopc.org
wadsig-owner@listbot.com

737-9099
469-4686
737-9099
831-1284
835-7656
246-7759
835-7656
913-5638

Other Important Numbers / Addresses
Club Hotline
NOPCC BBS
NOPCC Web Site

Recorded messages. Meeting Information. Open 24 Hours
Bulletin Board System for members. The original way to PC communicate.
On the World Wide Web. Our own home page and club information.

887-5746
486-7249
www.nopc.org

June 2003
Sun
1 Computer Solutions

Mon
2

WSMB Radio
1350AM
11:00a-12:00p

8 Computer Solutions
WSMB Radio
1350AM
11:00a-12:00p

15 Computer
Solutions WSMB
Radio 1350AM
11:00a-12:00p

22 Computer
Solutions WSMB
Radio 1350AM
11:00a-12:00p

29 Computer
Solutions WSMB
Radio 1350AM
11:00a-12:00p

9

Tue

VBLG
McCann’s
6:30p-8:30p

3

VBLG
McCann’s
6:30p-8:30p

16

VBLG
McCann’s
6:30p-8:30p

23

VBLG
McCann’s
6:30p-8:30p

Wed

Thu

4 NOPC Monthly

5 WEB SIG

Meeting
J.D. Meisler School
6:30P-9:00P

McCann’s
6:00p-9:00p

10

11 NOPC Board of

12 NOPC Web Lab

Genealogy SIG
McCann’s
7:00p-8:30p

Directors Meeting
McCann ‘s
6:30p-8:30p

McCann’s
6:30p-8:30p

17

18

19 New User’s SIG

Fri
6

25 Digital Media
SIG—McCann’s
7:00p-9:00p

26 Internet SIG
McCann’s
7:00p-9:00p

7 Living with Home
Electronics
WTIX Radio 690AM
10:00a-11:00a

13

14 Living with Home
Electronics
WTIX Radio 690AM
10:00a-11:00a

20

McCann’s
6:30P-8:30p

24

Sat

21 Living with Home
Electronics
WTIX Radio 690AM
10:00a-11:00a

27

28 Living with Home
Electronics
WTIX Radio 690AM
10:00a-11:00a

30

VBLG
McCann’s
6:30p-8:30p

The New Orleans Personal Computer Club (NOPCC) is a private non-profit organization chartered under the State of Louisiana. Its purpose is to provide an open forum for discussion
and education of the membership in the use and application of PCs, peripheral equipment and software. The opinions expressed in this newsletter are those of the author (s) and do not
necessarily reflect those of the NOPCC , its members or its officers. The club does not verify for accuracy the articles in this newsletter and leaves verification of accuracy to its readers.
Articles in this newsletter may be duplicated as long as credit is given to the author (s) and the NOPCC. Annual Dues Schedule: Regular Member, $40/yr.; Family Membership, $60/yr.;
and Students (under 21) , $20/yr. Meetings are held at 6:30 on the 1st Wednesday of each month at J.D. Meisler Jr. High School on Cleary Avenue in Metairie, Louisiana.

New Orleans Personal Computer Club
P. O. Box 8364
Metairie, Louisiana 70011

